
Laboratory no. 1 

Basic sound edition using Audacity software 

 

  
About Audacity 

Audacity is a free, easy-to-use, multi-track audio editor and recorder for Windows, Mac 

OS X, GNU/Linux and other operating systems. The interface is translated into many 

languages. You can use Audacity to: 

 Record live audio. 

 Record computer playback on any Windows Vista or later machine. 

 Convert tapes and records into digital recordings or CDs. 

 Edit WAV, AIFF, FLAC, MP2, MP3 or Ogg Vorbis sound files. 

 AC3, M4A/M4R (AAC), WMA and other formats supported using optional 

libraries. 

 Cut, copy, splice or mix sounds together. 

 Numerous effects including change the speed or pitch of a recording. 

 And more! See the complete list of features. 

About free software 

Audacity is free software, developed by a group of volunteers and distributed under 

the GNU General Public License (GPL). 

Free software is not just free of cost (like "free beer"). It is free as in freedom (like "free 

speech"). Free software gives you the freedom to use a program, study how it works, 

improve it and share it with others. For more information, visit the Free Software 

Foundation. 

Programs like Audacity are also called open source software, because their source code 

is available for anyone to study or use. There are thousands of other free and open 

source programs, including the Firefox web browser, the LibreOffice or Apache 

OpenOfficeoffice suites and entire Linux-based operating systems such as Ubuntu. 

 

http://manual.audacityteam.org/o/man/faq_recording_how_to_s.html#overdub
http://audacityteam.org/wiki/index.php?title=Changing_the_current_language#list
http://audacityteam.org/wiki/index.php?title=Changing_the_current_language#list
http://manual.audacityteam.org/o/man/tutorial_recording_computer_playback_on_windows.html
http://manual.audacityteam.org/o/man/tutorial_copying_tapes_lps_or_minidiscs_to_cd.html
http://manual.audacityteam.org/o/man/faq_editing.html#join
http://manual.audacityteam.org/o/man/mixing.html
http://manual.audacityteam.org/o/man/index_of_effects_generators_and_analyzers.html#Make_the_sound_faster.2C_slower.2C_lower_pitched_or_higher_pitched
http://audacity.sourceforge.net/about/features
http://audacity.sourceforge.net/about/license
http://www.fsf.org/
http://www.fsf.org/
http://www.mozilla.com/
http://www.libreoffice.org/
http://www.openoffice.org/
http://www.openoffice.org/
http://www.ubuntulinux.org/


 

 

 

 

 

 

 

 

 

 

 

 

 

 

Control toolbar:  

 

 

Selection 

Envelope - allows smooth volume changes to be made over the length of a track by 

means of embedded volume "control points".  

Draw – enables you to manually redraw the waveform 

Zoom 

Time shift  

Multitool – combines all five tools in one. One tool is available at a time, according to the 

mouse position. 

 

 

Control toolbar Meter toolbar Mixer toolbar Edition  toolbar 

Audio track 

with spectrum 

view 

Audio 

settings 

Audio 
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with sample 

view 

Standard project 

settings 



 

Move the cursor to the beginning of the project.  

If an area of track is selected, only that selection will be played. Otherwise, playback 

begins wherever the editing cursor is. 

To loop-play (play the track or selection over and over until you stop), hold 

down SHIFT while clicking Play. 

Clicking Record always begins recording in a new track at either the current cursor 

position or at the beginning of the current selection. 

Temporarily pauses playing or recording without losing your place. 

Stops playing or recording immediately, and releases Pause if depressed. You must 

stop playback or recording before you can use the "Skip" buttons below and before 

you can edit any audio. 

Move the cursor to the end of the project. 

 

Mixer toolbar 

 

This is the left-hand slider that lets you control the volume at which you listen to the mix 

of your project. This is a purely a "monitor" control. It does not affect the level of your 

mix and hence does not affect the level that audio is exported at. Adjusting the playback 

slider will not help if your mix is clipped. The playback slider does not affect the levels 

indicated by the playback meters which do reflect the level of the mix. 

This right-hand slider controls the level of the currently selected "Recording Device" 

in Device Toolbar. Inputs can also be chosen at "Recording Device" in Devices 

Preferences, in the operating system mixer or in any control panel that the sound card 

may have. The Recording Slider should then control that input. 

 

 

 

 

 

http://manual.audacityteam.org/o/man/audacity_selection.html
http://manual.audacityteam.org/o/man/glossary.html#clipping
http://manual.audacityteam.org/o/man/meter_toolbar.html
http://manual.audacityteam.org/o/man/device_toolbar.html
http://manual.audacityteam.org/o/man/devices_preferences.html
http://manual.audacityteam.org/o/man/devices_preferences.html


Meter toolbar 

 

The green bars show the playback level, and the red bars show recording level. L is the 

left channel and R is the right channel. 

The playback level displayed in Meter Toolbar reflects the combined amplitude of all 
the tracks in your project, in other words, the level of the mix as determined by the gain 
sliders on each track. 

The playback volume slider on Mixer Toolbar does not affect the playback meter - the 
purpose of the meter is solely to indicate what the loudness of the project audio would 
be were you to export it as an audio file. 

The right-hand edge of the lighter part of the bar shows the average level of the audio 
and gives a general indication of its perceived loudness. 

The right-hand edge of the darker part of the bar shows the current peak level of the 
audio, and relates directly to the dark blue shading in the waveform. 

The right edge lines indicate the highest peak level attained in the last few seconds. They 
disappear after playback or recording is stopped, or if you left-click on the recording 
meters. 
 

Edition toolbar 

 

 

 

 

 

 

 

 

http://manual.audacityteam.org/o/man/audio_tracks.html
http://manual.audacityteam.org/o/man/mixing.html
http://manual.audacityteam.org/o/man/audio_tracks.html#gain
http://manual.audacityteam.org/o/man/audio_tracks.html#gain
http://manual.audacityteam.org/o/man/mixer_toolbar.html
http://manual.audacityteam.org/o/man/file_menu.html#Export...
http://manual.audacityteam.org/o/man/audacity_waveform.html


 

Cut (Ctrl X)  

Copy (Ctrl C) 

Past (Ctrl V) 

Delete all audia but the selection (Ctrl T) 

Silence selected audio (Ctrl L) 

Undo (Ctrl Z)  

Redo (Ctrl Y) 

Zoom in (Ctrl 1)  

Zoom out (Ctrl 2) 

Zoom selection (Ctrl E) 

Fit project (Ctrl F)  

 

1. Create new project 

Save project with the names of group member as a name (for example: 

NowakMalinowski.aup). Audacity software will create a new catalog automatically. 

2. Project settings 

Enter the Edit -> Preferences... or press Ctrl + P. Check which devices are selected as 

input/output. Then go to the quality settings and set standard quality - 44100Hz, 32-bit 

float. 

3. Import an audio file 

Either drag the files into the current project window, or choose File -> Import -> Audio.... 

Files can be opened into a new project window with File -> Open.... 

The main formats Audacity plays as shipped are AIFF, AU, FLAC, MP2, MP3, OGG 
Vorbis and WAV. 

Please, import file C:\Windows\Media\chimes.wav 

 

 

 

http://manual.audacityteam.org/o/man/file_menu.html#import
http://manual.audacityteam.org/o/man/file_menu.html#Open...


4. Playing 

 

Try playing file from the beginning, then play only selected fragment, then try to play 

that fragment in the loop. 

Check the options in the audio settings of the track. Look at the spectrum view, change 

the sampling frequency and try to split stereo track. 

5. Recording 

Check the microphone connection and whether in mixer toolbar the microphone is 

selected as input. Delete existing audio track from the project and record short message: 

"one two three". The new track should appear immediately. 

 

Using the selection tool, cut unnecessary fragments of silence before the message and 

after the message.  

Save the project and export the audio track to the .wav file (onetwothree.wav). It will be 

used later. 

6. Basic edition 

By selecting and using Ctrl+L shortcut, silence unwanted noised fragments between the 

words. 

 



Select the word "three" and from edition menu choose the split tool. The new audio 

track should appear. Do the same with the word "two". Final result should look like this: 

 

By using time shift tool, shift the words, so the audio track should sound: "three two 

one". By holding SHIFT and clicking on audio track toolbars select all three tracks. From 

menu Project select Fast Mix. Tracks should be connected again in one audio track. 

Export this track as threetwoone.wav 

7. Denoising 

Close all opened tracks and import file onetwothree.wav 

 

Select fragment of the audio track, where no voice is recorded. 

In menu effects choose the option of denoising and collect the noise sample. Now select 

the whole track (Ctrl+A). Again go the the denoising options and click preview. If the 

preview track souns unnatural, decrease the strength of the effect. After that, just click 

Remove Noise. Export denoised audio track to the file onetwothree-denoised.wav. 

 

 

 

 



8. Tone generator + envelope tool 

Generate the 2s sinusoidonal tone with 200Hz frequency. Select from menu Generate -> 

Tone. 

Use the envelope tool  to make the smooth beginning and ending of the tone. 

 

Export this track as 200Hz.wav and 200Hz.mp3 (look at next point). 

9. Saving as MP3 

Audacity does not have built-in MP3 encoder. To save files as MP3, software will ask You 

about path to the LAME encoder. Please, download the file lame_enc.dll (for example 

from the site:  http://lame1.buanzo.com.ar/  ) . 

During the save Audacity will ask You about ID3 tag (name, artist, album etc.) 

10. Practical tasks 

 Generate two alternating tones 1 s with 100Hz frequency with two different 

amplitudes (1,0 and 0,5). Use the envelope tool to smooth the passage between 

tones. Sound should last about 6s. Save the result as task1.wav 

 Generate two alternating tones 1s with 100Hz and 1000Hz with amplitude 1,0. 

Use the envolope tool to smooth the passage between tones. Sound should last 

about 6s. Save the result as task2.wav 

 Generate four 1s noise pulses with exponentially decreasing amplitudes (1,0 ; 0,5 

; 0,25; 0,125). Use the envelope tool. Save the file as task3.wav 

 Generate four 1s noise pulses with lineary decreasing amplitudes (1,0 ; 0,7 ; 0,4 ; 

0,1). Save the result as task4.wav 

 Generate sequence of 2s sinusoidonal tones with frequencies: 200 and 8000Hz 

(file: task5a.wav); 1000Hz and 1200Hz (file: task5b.wav) 

 Generate 2s mix of sinusoidonal tones with freqency of 200Hz and 1000Hz. Save 

the result as task6.wav. 

 Try to record the typical musical scale "do re mi fa sol la si do". Use the spectrum 

analysis tool and the effect "Change tone" to adjust your voice pitch to match the 

frequencies in the table: 

 

 

 

http://lame1.buanzo.com.ar/


solmization note f[Hz] 

do 

re  

mi  

fa 

sol 

la 

si 

do 

C(4) 

D 

E 

F 

G 

A 

H 

C(5) 

261,63 

293,66 

329,63 

349,23 

392,00 

440,00 

493,88 

523,25 

 

Contest task (best group awarded bonus points):  

 

 Record a music jingle/joke for radio "Żak". The jingle must contain the exact 

words: “Studenckie Radio Żak Politechniki Łódzkiej” and be between 20 and 60 

seconds long.   

Mix your recorded voice (or synthesized speech from an online source, such as 

ivona) with some background music and/or sound effects in Audacity. Try to use 

Audacity tools to make the jingle sound clear and uniformly loud.  


